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Basics of Production
Production is the skill and process of producing use limited, non- or basic magical items. These items are fairly
unstable and only keep their potency up to 48 hours. They are easy to make in a short amount of time and may be crafted
at a guild hall or crafting area at any time during an event.
To create a production item, a character must have one or more of the Crafting Headers Alchemist, Infuser, or
Runesmith. He must go to the crafting area and pay the cost of the created item into a Guild Repository Box. The guild
master will verify the payment and issue a blank production tag for each item created. The player must roleplay his
character creating items at the crafting area and filling out the card for the item being created. The card will be similar to
Illustration A-1 below and must have all the lines completed to be considered a valid item. The guild master will verify
the item tag is filled out properly, dated, and has an appropriate phys-rep. He will then initial/stamp the tag as complete.
All items created must be attached to or contained within a Phys Rep at the time of creation and must stay with
the phys-rep at all times until used. This includes armor & weapons.

Guild Masters
Guild Masters are player-characters who can volunteer to perform the duties listed above. There can be several at
each event but all must be approved by the local plot team. They must check in with the plot team to have their
initials/stamp on file to be compared if there are any questions regarding an item. Guilds can be arranged however the
player-characters see fit but a separate lab/workshop phys-rep must be available for each of the separate Production
Headers or items from that Header cannot be crafted there. It is possible to have multiple guilds at a given location but
each must have appropriate phys-reps and Guild Masters.
On occasion, plot may limit the number/type of items being created due to in-game shortages of materials etc.
This may take the form of a hard limit on number of items created (in total) or an increase in cost to create some or all
types of production.
High Magic Guild Master and Production Guild Masters are separately approved by plot. A player may be
approved or either or both. Players must be experienced in Production rules/play to be a Production Guild Master.

Item Name: _________________________
Created by: _________________________
Cost in Silver Pieces: _______
Date Created: ______________
Guild Master Sig/Stamp:
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Alchemist
CP Cost - 5

The Alchemist is a character who has honed their ability to mix ingredients to create powerful Oils
(defensive), Elixirs (curative), and Poisons (offensive).
Alchemist 5

CP
Cost

Prerequisite

Attribute

Apply Poison

0

-

Passive

Improved Alchemy*
Intricate Flask*

2
2

-

Passive
Passive

Poison Mastery*

2

Apply Poison

Passive

Fling Toxin

4

Apply Poison

Passive

Extended Mixture*

1

-

Passive

Layering Oil

3

-

Passive

Memorize Recipe*

1

-

Passive

Potent Poisons

2

-

1 Earth

Abilities
Allows you to apply Alchemical Poisons to Weapon w/ 3
sec. rp
Alchemist is capable of making more complex Concoctions
Increases capacity of Flask by 5 sections, max. 20
May apply an additional Poison to your weapon; Max of 2
Purchases

May throw Poisons from your Flask
Intricate Flask; Alchemist may carry over one
mixture/Concoction from Flask till next event
Alchemist can apply second Oil to their clothes, must be
different from first Oil
Memorize Recipe to create Alchemical Concoction
When applying Poison to weapon, Alchemist may “Imbue
by Alchemy,” for “Double…” before 1 attack call

Apply Poison
CP Cost - 0
This Passive Ability allows the character to apply Alchemical Poisons to a weapon with 10 seconds of roleplay. At the end
of the roleplay, he must call “Imbue by Poison” and attach the tag to the weapon. See the Poisons section below for more
details.

Improved Alchemy*
CP Cost - 2
The Alchemist is capable of making more complex Concoctions. He is capable of making the next level of Concoctions.
This can be purchased three times, to gain access to level 2, level 3, and level 4 Concoctions respectively.

Intricate Flask*
CP Cost - 2
The Alchemist intricately modifies his Flask which increases the capacity by 5 sections. This can be purchased up to two
times, increasing the number of sections in the Flask up to a maximum of 20.

Poison Mastery*
CP Cost - 2
Prerequisite: Apply Poison

This Passive Ability allows the Alchemist to apply an additional poison to a weapon. This skill may be purchased twice.
When multiple poisons are applied, the Master wielding the weapon may choose which one to use first. If a weapon with
more than 1 Poison is wielded by someone without the Poison Mastery skill, all poisons become inert and useless until
wielded by a person with the Poison Mastery skill.
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Fling Toxin
CP Cost - 4
Prerequisites: Apply Poison

This Passive Ability allows the alchemist to touch a packet to his flask & throw a poison from it as a packet delivery. The
poison is immediately used regardless of success. It will be delivered as “<Type> Poison”, IE: “Slow Poison”.

Extended Mixture
CP Cost - 1
The Alchemist has modified his Flask to stabilize one of his concoctions. Each time this skill is purchased, the Alchemist
may carry over one mixture or Concoction from his Flask until his next event. This mixture/Concoction will remain in
his flask. This can be purchased a maximum of 3 times. Each attached tag to be extended must be marked “Extended”.
This extended concoction must be used on the next event attended up to a maximum of one year from its creation date.

Layering Oil
CP Cost - 3
The Alchemist knows the most efficient way to protect themselves with Oils. An Alchemist who has purchased this skill
can apply a second Oil to his own clothes. The second Oil must be different than the first, as per the rules regarding
Granted Defenses.

Memorize Recipe*
CP Cost - 1
The Alchemist can memorize a complex recipe. When purchased, the Alchemist may pick a Recipe he possesses and
expend a charge from that recipe. The Alchemist may now create one copy of that Concoction per day. Only one recipe
may be memorized per event. When memorized, record on your character sheet “Memorized Recipe: <Recipe Name>.”
This skill may be purchased multiple times, each time granting access to a different recipe, or granting the ability to create
an additional copy of a known recipe per day. The Alchemist must have the ability to create a substance of the required
level to memorize the recipe.

Potent Poisons
CP Cost - 2
The Alchemist knows exactly how to apply a Poison to do the most damage. When applying a Poison to a weapon, the
Alchemist may spend 1 Earth and call “Imbue by Alchemy.” When swinging the Poison effect of that weapon, the user
may call “Double…” before the attack call. This has no effect on a Poison that already has the Double or Triple modifier.
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The Basics – All about Concoctions
Alchemists start with access to the Level 1 Concoctions, but may purchase the Improved Alchemy skill to create
more advanced recipes.
To create a Concoction, you must have the Alchemy skill and you must know how to create a specific concoction.
Many Concoctions are considered common, and the recipes are readily available. Any Concoctions that list a recipe
requirement are considered somewhat rare, and a recipe must be found before the Concoction can be made. Recipes also
have charges, and each Concoction made from a recipe will use a charge from a recipe. Once a recipe is out of charges, it
can no longer be used to create Concoctions. The Alchemist must have the required level of Alchemy needed to produce
the concoction in order to use a recipe.
Most Concoctions are made using a variety of mundane ingredients that are readily available. In these cases, all
that is required is an amount of gold in order to obtain those ingredients. Any specific ingredients listed in the cost of a
Concoction are considered rare and limited, and must be found by the character before they can make that Concoction.
Concoctions take a lot of time to prepare and must be made before the event. In order to create Concoctions, a
character is required to submit an Alchemy sheet during check in or check out, or by contacting logistics between events,
and must pay the cost of the Concoctions.
Unless otherwise noted, Concoctions will last approximately one year before their magic fades. Anyone is capable
of using a bottled Concoction, but Concoctions placed in an Alchemists Flask cannot be used by anyone but the
Alchemist.
An Alchemist uses an Alchemy Lab to perform actions in-game. The Alchemy Lab is represented by a table or a
stand covered in bottles, flasks, and other scientific equipment. This area should be about 3’ x 3’. Multiple Alchemists may
use the same Lab. Due to the volatile nature of Alchemical mixtures, the lab cannot be moved.
The three most common types of Concoctions are Elixirs, Poisons, and Oils.

Alchemist’s Flask
Every Alchemist carries Alchemist’s Flask. Alchemy Flasks can be used to store Concoctions for quick use.
Additionally, Alchemists have many skills that allow them to perform Alchemical feats with substances in their Flask. An
Alchemist’s Flask is divided into sections, which allow the Alchemist to store multiple substances in one container. The
standard Flask has 10 sections, but there are skills that allow the expansion of this Flask. A concoction in a flask must have
a tag placed or attached to the Flask and must be marked “Flask”. Substances placed into a Flask cannot be taken back
out.
The benefit of the flask is that it allows for easy use of concoctions. In order to use a Poison or an Oil from a Flask,
simply touch a packet to the opening of the flask and then touch it to the target of the concoction. This does not decrease
the time it takes to apply oils or poisons, but you may do so without reading the tag. Elixirs in a flask may be delivered
with 3 seconds of roleplay without having to read the tag.
A Flask must be a container that can be closed that is at least 6” tall and must appear to hold liquids. The Flask
must be made in a safe manner, using materials that will not break easily and do not have sharp edges. Alchemists are
frequently create customized Flasks to show off their skills.

Poisons
Poisons must be either phys-repped by a small vial or placed directly in an Alchemical Flask at the time of
creation. Vials need to be large enough to hold the tag or to have the tag attached to the item, and must appear be able to
hold liquid. They must be applied to weapons or, with the correct skill, thrown to cause devastating effects. Poisons
ingested from a flask or vial take full effect but may not be applied to food or drink.
Poisons cannot be applied or thrown without an appropriate skill. At the end of the roleplay, he must call “Imbue
by Poison” and attach the tag to the weapon. That weapon now swings an effect based on the particular Poison used. A
player must swing that effect until a character calls a defense or roleplays taking the effect. A weapon coated in Poison
cannot be used for any other offensive strikes, and the Poison is consumed if the player loses possession of the weapon or
if the weapon is used for any other attack. Some effects may exist that improve the use of Poison.
Alchemists may also place add a poison from a vial into their Flask. This requires 10 seconds of roleplay at an
Alchemist lab. At the end of 10 seconds, the Alchemist marks the Concoction tag as “Flask” and places it in the Flask.
Each Poison takes up 1 section in the Flask, unless otherwise noted on the tag.
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Poisons are represented by vials. These vials need to be large enough to hold the tag or to have the tag attached
to the item, and must be able to hold liquid.

Elixirs
Elixirs are Concoctions that are ingested for beneficial effects. These effects could include Healing, Resists, and
Grant effects.
Bottled Elixirs are ingested by performing 3 seconds roleplay drinking the substance. At that point, the character
receiving the effect must read the tag, to know what effect happens. In-game, the time required to read the tag represents
disorientation before the effect sets in. If it is too dark to read the tag, an Elixir cannot be used. The character takes all
effects on the tag, including any side effects. Additionally, you may feed an Elixir to someone by performing 3 seconds of
roleplay feeding it to him or her, whereupon you will deliver the effect via touch.
Elixirs in an Alchemist’s Flask are ingested by performing 3 seconds of roleplay. If the Alchemist is applying it to
another character, they state the effect. There is no need to read a tag, and therefore no need for light.
Elixirs can only be identified by an Alchemist. Doing so requires the amount of time it takes to read the tag. If
the Elixir has a side effect, the Alchemist takes this effect when identifying it.
Alchemists may also place Elixirs into their Flask. This requires 10 seconds of roleplay at an Alchemist lab. At
the end of this 10 seconds, the Alchemist marks the Concoction tag as “Flask” and places it in the Flask. Each Elixir takes
up 1 section in the Flask, unless otherwise noted on the tag. Elixirs in a Flask last until the end of the event, but may be
extended from other Alchemist skills.
Elixir phys-reps must be able to be opened and closed, appear to hold liquid, and be large enough to hold the tag
or have the tag attached to the representation.

Oils
Oils are alchemical substances that are applied to an individual’s clothes or armor to prevent certain attacks.
Oils are applied to an individual through 10 seconds of roleplay, followed by touching a packet to the tag and
then to the recipient. They are then handed the tag and call the effect. Characters may only benefit from a single Oil at
any time, and applying an Oil destroys any previously applied Oil.
Oils can only be identified by an Alchemist and takes as long as it takes to read the tag.
Alchemists may also place Oils into their Flask. This requires 10 seconds of roleplay at an Alchemist lab. At the
end of 10 seconds, the Alchemist marks the tag as “Flask” and places it in the Flask. Oil takes up 1 section in the Flask,
unless otherwise noted on the tag. Oils in a Flask last until the end of the event, but may be extended from other
Alchemist skills.
Oil phys-reps must be able to be opened and closed, appear to be able hold liquid, and be large enough to hold
the tag or have the tag attached to the representation.

Types of Alchemy
Below are the Poisons, Elixirs, and Oils you can make, once you purchase the appropriate Alchemist skills to do so.

Level 1 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Alchemy Header.
Lesser Restoration Elixir: <Effect>
Cost: 1s
This produces an Elixir capable of fixing a specific effect from the list below. When applying this Elixir, call “Cure
<Effect> by Alchemy.”
Effects: Agony, Maim, Repel, Root, Slow
Minor Health Elixir
Cost: 1s
This produces an Elixir capable of healing the recipient. After drinking the Elixir, call “Heal 2 by Alchemy.”
Numbing Venom
Cost: 1s
This Poison can be applied to a weapon, to allow the user to swing “Slow by Poison.”
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Pain Venom
Cost: 1s
This Poison can be applied to a weapon, to allow the user to swing “Agony by Poison.”
Weapon Resistance Oil
Cost: 1s
This produces a vial of Oil that protects the user from weapons. “Grant Weapon Defense by Alchemy, Shield.”
Snake Bite Venom
Cost: 1s
This Poison can be applied to a weapon, to allow the user to swing “5 Damage by Poison”.
Caustic Acid
Cost: 1s
This mixture must be loaded directly to the Alchemists Flask at the time of creation. It must be thrown for “3 Damage by
Acid”.

Level 2 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill at least once.
Anti-venom Elixir
Cost: 2s
This produces an Elixir capable of protecting the user from Poisons. After drinking the Elixir, call “Grant Poison Defense,
Shield.”
Corrupting Venom
Cost: 2s
This Poison can be applied to a weapon, to allow the user to swing “Stricken by Poison.”
Protective Oil - <Elemental/Mental/Metabolic/ or Physical>
Cost: 2s
This produces a vial of Oil which protects the user from various Trait groups. “Grant <Elemental/Mental/Metabolic/ or
Physical> Defense by Alchemy, Shield.”
Restoration Elixir: <Effect>
Cost: 2s
This produces an Elixir capable of fixing a specific effect. When applying this Elixir, call “Cure <Effect> by Alchemy.”
Effects: Drain, Paralyze, Silence, Stricken, Stun.

Level 3 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill at least twice. These
Concoctions are considered Master Crafted, and possess the “Mastercraft” Trait.
Anti-Necrotic Oil
Cost: 5s
This produces a vial of Oil that protects the user from death. “Grant Death Defense by Alchemy, Shield.”
Nerve Freeze Venom
Cost: 3s
This Poison can be applied to a weapon, to allow the user to swing “Paralyze by Poison.”
Purging Elixir: <Trait Group>
Cost: 3s
This produces an Elixir capable of fixing a variety of effects. When applying this Elixir, call “Cure <Trait Group> by
Alchemy.”
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Scorpion Venom
Cost: 3s
This Poison can be applied to a weapon, to allow the user to swing “Drain and 3 Damage by Poison.”

Level 4 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill three times. These
Concoctions are considered Master Crafted, and possess the “Mastercraft” Trait.
Life Elixir
Cost: 5s
This produces an Elixir capable of fixing death. When applying this Elixir, call “Cure Death and Heal 5 by Alchemy.”
Thick <Oil>
Cost: Varies
This produces a more protective version of one of the Alchemist Oils. This works the same as previous Oils, but call
“Double Grant…” in front of the effect. Thick Oils Cost 3 times more than the standard Oil effect.
Widowmaker Venom
Cost: 5s
This Poison can be applied to a weapon, to allow the user to swing “Death by Poison.”
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Infuser
CP Cost - 5
Infusers are able to create Wands (spells effects) & magical Potions (Restore Attributes).
Skill Name

CP Cost

Prerequisites

Attributes

Improved
Infusion*
Wand Mastery*
Drain Wand

2

-

Passive

Able to make more advanced Infusions

2
3

-

Passive
Elite

Potion Potency
Extend Infusion*
Overload Wand
Knowing
Another’s Art*

3
1
3
1

-

Passive

Infuser may use Wand an additional time during battle
Infuser can drain Wand w/ at least 3 charges to refill own
magic reserves, “With Magic, Refresh 1 Spirit to Self”
Gain 1 Extra Attribute when using a Potion
Extend an Infusion beyond the current event
“With Magic, Double (spell incant) when using a Wand
Infuser is skilled at creating Wands for spell they do not
know; must have recipe, Can use wands

1 Fire
Passive

Abilities

Improved Infusion*
CP Cost – 2
The Infuser is capable of making more advanced Infusions. This skill can be purchased up to three times, and each
purchase grants access to higher level Infusions.

Wand Mastery*
CP Cost – 2
The Infuser is experienced in the use of Wands. This skill allows the Infuser to use a Wand an additional time before
requiring Rest. This skill can be bought up to two times.

Drain Wand
CP Cost – 3
Once per day, the Infuser can drain a Wand in order to refill their own magic reserves. By completely draining a Wand
with at least 3 charges left, an Infuser can call “With Magic, Refresh 1 Spirit to Self.” This counts as a use of a Wand with
regards to requiring Rest. You may spend a Fate to use this Ability again. When doing so, the call is “With Fate, Refresh
1 Spirit to Self.”

Potion Potency
CP Cost – 3
This Passive ability grants the Infuser an extra Attribute when using a Potion to Refresh Earth, Fire, Air, or Water.

Extend Infusion*
CP Cost – 1
The Infuser is capable of extending a Potion or Wand. For each purchase of this skill, the Infuser may extend one Infusion
that would normally expire at the end of the event for up to a year from the time of creation. The next time that character
plays, they will start the game with that Infusion or Wand and it must be used in that following event or it will lose its
power. This skill can be purchased a maximum of 3 times.

Overload Wand
CP Cost – 3
The Infuser can tap into the reserves of the Wand to perform great feats. By spending 1 Fire and using 2 charge of a
Wand, the Infuser may call “With Magic, Double…” before the normal call. This counts as a single use of a Wand with
regards to requiring Rest.
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WAR Accelerant – Shattered Lands - Production Rules (Play Test) v 5.6 – 2022

Knowing Another’s Art*
CP Cost – 1
The Infuser can craft Wands for a Spell they do not know. When purchased, the Infuser may pick a recipe that they
possess and expend a charge from that Recipe. The Infuser may now create one copy of that Wand of that Spell per day.
Only one recipe may be memorized per event. When this skill is purchased, record on your character sheet “Knowing
Another’s Art: <Recipe Name>.” This skill may be purchased multiple times, each time granting access to a different
spell, or granting the ability to create an additional Wand of a known spell per day. The Infuser must have the ability to
create an Infusion of the required level to memorize the recipe. An Infuser may use a wand in which he doesn’t have the
header but does know the spell from Knowing Another’s Art.

The Basics – All about Infusions
Infusers start with access to the Level 1 Infusions, but may purchase the Improved Infusion skill to create more
advanced recipes.
To create an Infusion, you must have the Infusion skill and, in the case of wands, know the spell being placed into
it. Many Infusions are considered common. Any Infusion that lists a recipe requirement is considered somewhat rare,
and a recipe must be found before the Infusion can be made. Recipes also have charges, and each Infusion made from a
recipe will use a charge from a recipe. Once a recipe is out of charges, it can no longer be used to create Infusions.
Level 3 and Level 4 Infusions are considered Master Crafted, and possess the “Mastercraft” Trait.
Most Infusions are made using a variety of magical ingredients that are readily available. In these cases, all that is
required is an amount of gold in order to obtain those ingredients. Any specific ingredients listed in the cost of an
Infusion are considered rare and limited, and must be found by the character before they can make that Infusion.
Anyone is capable of using a Potion but use of a wand requires the user to know the Header from which the spell
originates. Identification of an Infusion can only be performed by someone with the Infusion skill. This identification
takes as long as it takes the character to read the tag for the item.
An Infuser uses a Weave Tap to perform actions in-game. The Weave Tap is represented by a table or stand
covered in magical symbols and equipment. This area should be about 3’ x 3’. Multiple Infusers may use the same
Weave Tap. Due to the nature of The Weave, the Weave Tap cannot be moved.
The three most common types of Infusions are Wands & Potions.

Wands
Wands are implements that can be infused with magical spells.
Each Wand will have a single spell stored within. The Wand will have a number of charges, which represents the
number of times a spell can be cast before the magic on the Wand fades. The call phrase for casting from a Wand is “With
Magic, (Spell verbal).” In order to use a wand, you must be holding the wand an otherwise empty hand (this does not
count as an item in hand with regard to spellcasting rules.) Casting a spell from a Wand will use up a charge on the
Wand, but will not require that any Attributes be spent by the character. If there are no more charges on the Wand, the
tag is destroyed.
Using a Wand is taxing for people who are unfamiliar with the process. For that reason, characters can only utilize
a single charge from any Wand before their mind is exhausted. That character must take a Standard Rest minutes before they
can use a Wand again. Some Infusers have become accustomed to casting from Wands, and may be able to utilize
multiple charges before they need to Rest.
In order to create a Wand, an Infuser must know the spell that is being put into the Wand. In order to broaden
the number of Wands that can be created, an Infuser must learn more spells. On rare occasion, an Infuser might find a
recipe that permits them to create a Wand for a spell they do not know. These recipes are highly sought after, so finding
them might be difficult.
Wands are represented by sticks or rods that are 6” to 12” in length. These can be made out of nearly any
material, as long as there are no sharp parts that could cause a safety hazard. Often, wands appear highly ornate to show
off the skill of the Infuser. A Wand with a flame spell may be made out of metal and painted red with flicks of yellow,
while a Wand with necromancy may be made of withered wood painted black.

Potions
Unlike Elixirs, which have particular effects upon a person, Potions are used to restore magic within a character.
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Most commonly, Potions are used to restore the four basic Attributes. However, there may be Potions that are
capable of Restoring Spirit Attribute or Elite skills. And in rare circumstances, there may be Potions capable of granting
or removing character traits.
Potions used to Refresh Attributes will not increase Attribute levels to higher than the character’s maximum,
unless otherwise specified.
Potions can only be truly be identified by an Infuser, even if they are marked in an in-game manner.
Using a Potion requires 3 seconds of roleplay of drinking the potion & the user to read the tag after. If it is too
dark to read the tag, then the Potion cannot be used.
Potion phys-reps must be able to be opened and closed, appear to be able hold liquid, and be large enough to
hold the tag or have the tag attached to the representation.

Types of Infusions
Below are the Wands & Potions which are common to make.

Level 1 Infusions
These Infusions can be made by any Infuser.
Lesser Attribute Potion: <Type>
Cost: 2s
This produces a Potion that Restores 1 point in one of the 4 basic Attributes. The Potion is specific to the Attribute chosen
during creation. After drinking the Potion, the character would call “Refresh <Attribute>” with the Attribute being one of
Earth, Fire, Air, or Water.
Lesser Magic Wand: <Spell>
Cost: 2s
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 1 or less, and cannot contain Elite spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that is not on the Infuser’s
character card.

Level 2 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill at least once.
Quality Attribute Potion: <Type>
Cost: 4s
This produces a Potion that Restores 2 points in one of the 4 basic Attributes. The Potion is specific to the Attribute
chosen during creation. After drinking the Potion, the character would call “Refresh <Attribute>” with the Attribute
being one of Earth, Fire, Air, or Water.
Quality Magic Wand: <Spell>
Cost: 5s
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 2 or less, and cannot contain Elite spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that is not on the Infuser’s
character card.

Level 3 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill at least twice. These Infusions
are considered Master Crafted, and possess the “Mastercraft” trait.
Greater Attribute Potion: <Type>
Cost: 6s
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This produces a Potion that Restores 3 points in one of the 4 Basic Attributes. The Potion is specific to the Attribute
chosen during creation. After drinking the Potion, the character would call “Refresh <Attribute>” with the Attribute
being one of Earth, Fire, Air, or Water.
Greater Magic Wand: <Spell>
Cost: 10s
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 3 or less, and cannot contain Elite spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that that is not on the Infuser’s
character card.

Level 4 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill three times. These Infusions
are considered Master Crafted, and possess the “Mastercraft” Trait.
Master Attribute Potion: Spirit
Cost: 10s
This produces a Potion that Restores 1 Spirit at the cost of 1 Fate. After drinking the Potion, the character would call
“With Fate, Refresh Spirit.”
Master Attribute Potion: <Type>
Cost: 10s
This produces a Potion that Restores 4 points in one of the 4 Basic Attributes. The Potion is specific to the Attribute
chosen during creation. After drinking the Potion, the character would call “Refresh <Attribute>” with the Attribute
being one of Earth, Fire, Air, or Water.
Master Magic Wand: <Spell>
Cost: 15s, Recipe (optional)
This produces a magic Wand with 3 charges that can contain the effects of any Elite spell on the Infuser’s character card.
Casting a spell from a Wand consumes one charge. A specific recipe may be used in order to create a Wand for a spell is
not on the Infuser’s character card.
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Runesmith
CP Cost - 5
The Runesmith is a character that is skilled in armor and weapon construction. In addition to being a spectacular
mundane craftsman, she has become very skilled at enhancing craftsmanship. It does not make the object magical, but
can add a supernatural effect or ability. A Runesmith is capable of making Weapon/Armor Runes, Flesh Runes, and
Portal Runes.
Runesmith 5

CP
Cost
0
2

Prerequisite

Attributes

-

Passive
Passive

May engrave Runes onto Weapons/Armor at Forge
May make more advanced Runes; Max of 3 Purchases

2

-

Passive

Expert Smithing

3

-

Passive

Scarred Flesh
Call the Armor

3
2

Passive
1 Water

Call the Weapon

2

Runic Reinforcement

2

Expert
Smithing
Expert
Smithing
-

May use 2 additional Weapon/Armor Runes; Max of 2
Purchases
May Repair Weapons/Shields/Items/Armor without
Forge.
Runesmith gains 2 uses when consuming Flesh Runes
3 Seconds rp, “Refresh All Armor by Awe”

Runic Extension*

1

-

Passive

Heavily Armored*

2

Armored

Passive

Engrave Rune
Improved
Runesmithing*
Runic Mastery*

1 Fire
Passive

Abilities

3 Seconds of rp, “Repair Weapon by Awe” or “Repair
Shield by Awe”
Use any Weapon/Armor Rune to Repair Weapon or
Refresh Armor; “Refresh All Armor by Rune” or
“Repair Weapon by Rune”
Extend Unused Armor, Weapon, or Flesh Runes
beyond end of the event; Max of 3 Purchases
Gain 1 Armor Point; Max of 3 Purchases

Engrave Rune
CP Cost – 0
The Runesmith may create & engrave Runes at a Forge.

Improved Runesmithing*
CP Cost – 2
The Runesmith is capable of making more advanced Runes. This skill can be purchased up to three times with each
purchase granting access to higher-level Runes.

Runic Mastery*
CP Cost – 2
The Runesmith is better attuned to his equipment. This skill allows the Runesmith’s Armor and Weapons to benefit from
2 additional Runes beyond the maximum of 3. This skill can be bought twice, allowing her to have a maximum of 7
Runes on their armor and weapons.

Expert Smithing
CP Cost – 3
The Runesmith is experienced at common weapon and item repairs. The Runesmith can spend 60 seconds of roleplay
with a tool to repair armor, weapons, shields, and items without requiring a forge. This requires a metalworking
representation with no sharp edges. At the end of 60 seconds, call “Refresh All Armor”, “Repair Weapon”, “Repair
Shield”, or “Repair Item.”
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Scarred Flesh
CP Cost – 3
The Runesmith is used to scarring his flesh and is better able to utilize Flesh Runes. Any Flesh Rune on the Runesmith’s
body can be used twice before the magic fades. Flesh Runes that have been used once cannot be extended with the Runic
Extension skill.

Call the Armor
CP Cost – 2
While the Runesmith typically fixes armor with tools, they are also capable of talking to the spirits of the armor. By
roleplaying talking to someone’s armor for 3 seconds and spending 1 Water, the Runesmith may call “Refresh All Armor
by Awe.” If the person wearing the armor or any of their possessions is hit with any weapon, missile, or packet attack
during this process, the effect is interrupted and no Attributes are spent.

Call the Weapon
CP Cost – 2
While the Runesmith typically fixes a weapon or shield with tools, they are also capable of talking to the spirits of those
items. By roleplaying talking to someone’s weapon for 3 seconds and spending 1 Fire, the Runesmith may call “Repair
Weapon by Awe” or “Repair Shield by Awe.” If the person wielding the weapon or any of their possessions is hit with
any weapon, missile, or packet attack during this process, the effect is interrupted and no Attributes are spent.

Runic Reinforcement
CP Cost – 2
The Runesmith is capable of convincing his Armor and Weapon to continue battle. A Runesmith may consume any
Armor Rune on their armor to call “Refresh All Armor by Rune” and consume any Weapon Rune on their Weapon to call
“Repair Weapon by Rune.” The Rune used to perform this action immediately fades, regardless of its normal duration.

Runic Extension*
CP Cost – 1
The Runesmith is capable of extending Runes on their Armor, Weapons, and Flesh. For each purchase of this skill, the
Runesmith may extend one Rune that would normally expire at the end of the event for up to a year from the time of
creation. The next time that character plays, they will start the game with that Rune on their Armor, Weapon or Flesh and
it must be used in that following event or it will lose its power. This skill can be purchased a maximum of 3 times.

Heavily Armored 2*
CP Cost – 2
Prerequisite: Armored
This Passive ability gives the character access to more armor. The character gains 1 additional point of maximum Armor.
In order to gain the benefit of this skill, you must be wearing Leather, Chain, or Plate armor. This skill can be bought up
to 3 times, and a character can never have more than 4 points of Passive Armor. This skill does not count as a prerequisite
for other skills under this Header.

The Basics – All about Runesmithing and Runes
Runesmiths start with access to the Level 1 Runes, but may purchase the Improved Runesmithing skill to create
more advanced recipes.
To create a Rune, you must have the Runesmithing skill and you must have access to the recipe for that particular
Rune. Many Runes are considered common, and the recipes are readily available. Any Rune that lists a recipe
requirement is considered somewhat rare, and a recipe must be found before the Rune can be made. Recipes also have
charges, and each Rune made from a recipe will use a charge from a recipe. Once a recipe is out of charges, it can no
longer be used to create Runes.
Level 3 and Level 4 Runes have the “Mastercraft” Trait.
Most Runes are made using a variety of mundane supplies that are readily available. In these cases, all that is
required is an amount of gold in order to obtain those supplies. Any specific ingredients listed in the cost of a Rune are
considered rare and limited, and must be found by the character before they can make that Rune.
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Runesmiths must etch Runes onto an item or portal placard at the time of creation. Etched Runes normally last
until they are used or until the end of the event. Anyone is capable of using a Rune once they are etched onto an item.
A Runesmith uses a Forge to perform actions in-game. The Forge is represented by a table or a stand covered in
metalworking tools. This area should be about 3’ x 3’. Due to weight of the equipment and the time to set it up, the forge
cannot be moved in-game.
The four common types of Runes are Weapon Runes, Armor Runes, Flesh Runes, and Portal Runes.

Weapon and Armor Runes
Weapon and Armor Runes are etchings that can be placed on weapons, shields, and armor to enhance their
abilities. These enhancements can be anything from allowing Armor to be repaired quickly or for a weapon to hold
Poisons until the user wants to use them. Shields count as weapons in regards to what Runes may be placed on them.
Runes may not be placed on claws, unless specified by the recipe.
Each Rune will have a specific effect they perform. Many Runes will be completely expended whenever used,
while some may have a Passive effect that lasts until the end of the current event. Any character can have a total of 3
Armor and/or Weapon Runes etched on their person at any given time, but some Runesmiths can increase that total for
themselves.
Runes must be applied to the weapon, armor, flesh or portal placard at the time of creation. Runes applied to
Weapons or Armor are absorbed into the Metal or Leather and are not visible but the person wearing it must keep the tag
with them.

Flesh Runes
While placing Runes onto Armor and Weapons is considered a common occurrence, burning Runes onto one’s
flesh is a little less common and a little less socially acceptable. Many Runesmiths find Flesh Runes to be appalling and
consider it to be a twisted mutation of what Runesmithing is about. Despite this line of thought, Flesh Runes can
certainly be utilized to good effect.
Flesh Runes can be applied to a character at a forge. This requires 10 seconds of roleplay per rune, where the
Runesmith brands the Rune onto the target. Please do not use any actual fire to represent this! At the end of 10 seconds,
call “Imbue Flesh by Rune.” The target of the Flesh Rune gains the power of the Rune, but also gains the “Flesh”
character trait.
A character may only have a single Flesh Rune on their body at any given time. In order to utilize the power of
the Rune, the Rune must be exposed and visible. It can, however, be hidden until a time when its power is required.
Once a Flesh Rune’s power is utilized, it will soon disappear from the character’s skin, and the “Flesh” character trait is
lost.
Once branded, a Flesh Rune is represented with a pattern or picture on the character’s skin. This should be
applied by make-up that can be easily removed but will not stain a character’s costume. This Rune should cover a
minimum of a 1” x 1” space of skin. In order to use a Rune, the representation of the Rune must be exposed. Once a Rune
is used, the player may remove the representation at their first convenience. They will not lose the “Flesh” trait until this
representation is removed.

Portal Runes
Portal Runes are Runes that bring out the power of a particular doorway or portal. The portal placard must be applied to
the doorway, and will affect people trying to move through the portal.
It takes 60 seconds to apply the created Portal Placard to a doorway. In this time, the player should hang up the Portal
plaque and the caution sign explaining the effects. The Runesmith applying the Portal Rune will automatically be attuned
to that Rune. The Runesmith may also attune anyone they choose who was within arm’s reach at the end of the 60
seconds. Rooms with more than one doorway require multiple Portal Runes on separate placards. If representations
aren’t put up on both doorways, the doorway without the representation will not be protected in any way. This rule
applies to tents which have two entrances. As per WAR Accelerant rules, you cannot enter or exit through windows, so a
portal rune is not necessary there.
Once applied, the Portal Rune will affect people trying to pass through the portal. These effects can include a verbal
alarm, damage, effect, or blocking the entrance. Anyone who is attuned to the Portal Rune may pass the Rune by
standing in front of it and concentrating for 3 seconds. To allow another person to bypass the rune, the invested person
must concentrate for 3 seconds then state “By your name, <Name>, you may enter. Anyone attuned to a Portal Rune may
permanently remove the Portal Rune by touching the rune and concentrating for 60 seconds. The PC character may then
remove the portal placard.
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Anyone attuned to a Portal Rune may attune others. This requires 60 seconds of Focus. During this time, the player will
add the target’s name to the list of people attuned to the Rune. The person to be attuned must be within Arm’s reach
during these 60 seconds and have their character name added to the rune tag. Anybody may remove themselves from a
portal rune by touching the Portal Rune Placard for 60 seconds of Focus and crossing their name off the list. Also, a
person may be forcibly removed from the Portal Rune by disabling them and touching them with a packet and also
touching the portal rune placard for 60 seconds of Focus and striking their name from the rune.
Multiple Portal Runes may be placed on the same doorway or portal. However, you may only apply Portal Rune
to a Portal if you are currently attuned to all existing Portal Runes on that portal. Each Portal Rune will have its own
portal placard representation and caution sign.
Portal Runes are represented by a plaque of at least 3” x 3” with a Rune drawn or etched into it. There should be
sufficient room on the back of a Portal Rune to add a list of Attuned people and the tag for the Rune.

Types of Runes
Below are Weapon/Runes, Flesh Runes, and Portal Runes you can make, once you purchase the appropriate
Runesmithing skills to do so.

Level 1 Runes
These Runes can be made by any Runesmith.
Rune of Repair
Cost: 1s
This Rune must be etched onto either a suit of armor, shield, or weapon and the tag attached to the corresponding item.
This Rune allows the user to have a single use call “Refresh All Armor by Rune”, “Repair Weapon by Rune”, or “Repair
Shield by Rune” to the corresponding item.
Portal Rune of Alarm
Cost: 2s
This Portal Rune may be etched onto a doorway placard at a Forge then hung on any single doorway. Anyone who
triggers this Portal Rune must announce, in a loud voice, “Alarm Rune! Alarm Rune! Alarm Rune!”
Elemental Weapon Rune: <Trait>
Cost: 1s
This Rune may be etched onto a weapon. This Rune allows the user to call “5 Damage by <trait>.” Possible Traits include
Fire, Ice, Earth, and Lightning.
Flesh Rune of Stability
Cost: 1s
This Rune may be etched onto someone’s skin. If the wearer is ever dropped to unconscious unstable, they may consume
this rune to call “Stabilize to Self by Rune.”

Level 2 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill at least once.
Armor Rune of Protection
Cost: 2s
This Rune may be etched onto a suit of armor. This Rune allows the user a single use to call “Reduced by Rune” against
any one attack with a Physical Trait. Instead of taking the effect, the character takes 1 point of damage. If this reduces the
character to 0 Vitality, they go Unconscious Stable.
Weapon Rune of Poisoning
Cost: 5s
This Rune may be etched onto a weapon. This Rune allows the owner to freely use a Poisoned weapon for normal
damage, without losing the effect of the Poison. Poison is still expended when it successfully strikes a target.
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Weapon Rune of Parrying
Cost: 2s
This Rune may be etched onto a weapon or shield. This Rune allows the owner a single use to call “Parry by Rune”
against any one weapon or missile attack.
Portal Rune of Assault
Cost: 5s
This Portal Rune may be etched onto a Portal Placard and hung on a doorway. Anyone who triggers this Portal Rune
receives the effect “5 Damage by Magic.”
Armor Rune of Blade Turning
Cost: 2s
This Rune may be etched onto a suit of armor. If the character is brought to 0 Vitality by called damage from a melee or
missile attack, they can use the Rune to become stable.
Flesh Rune of Healing
Cost: 3s
This Rune may be etched onto someone’s skin. This Rune allows the user to add 2 to any “Heal” effect they use twice. If
both of these effects were delivered by touch, then the Rune may be used a third time. Finally, the Rune may be fully
consumed to call “Heal 2 to self by Rune” and may be activated immediately when reduced to 0 body.

Level 3 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill at least twice. These
Runes are considered Master Crafted, and possess the “Mastercraft” Trait.
Armor Rune of Reinforcement
Cost: 10s
This Rune may be etched onto a suit of armor. If the character has less than 4 points of Passive armor, this character is
under the effect of “Imbue by Rune.” While wearing that armor, the character has 1 additional point of Passive Armor.
This Rune stacks (up to a maximum of 4 armor) and also stacks with “Grant Armor” effects.
Armor Rune of Survival
Cost: 5s
This Rune may be etched onto a suit of armor. When struck by any Death effect, the character receives one use of Resist
Death and may call “Resist Death by Rune.”
Weapon Rune of Aggression
Cost: 10s
This Rune may be etched onto a melee weapon. This Rune allows the owner to add 1 to all called melee strikes against a
single target with this weapon.
Portal Rune of Protection
Cost: 10s
This Portal Rune must be etched onto a Portal Placard and hung doorway to become active. As long as this Portal Rune is
active, anyone not invested cannot pass through the doorway. Mechanics for Portal Runes that allow a character to pass
through without triggering the Rune can be used to pass freely through the portal. While those not invested in the Portal
Rune must be allowed into a portal protected by the rune, anyone may freely exit.
Flesh Rune of Skill
Cost: 10s
This Rune may be etched onto someone’s skin. This Rune will allow a character to reduce the Attribute cost of any ability
by 1 Attribute up to three times.

Level 4 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill three times. These Runes
are considered Master Crafted, and possess the “Mastercraft” Trait.
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Armor Rune of Lasting Repair
Cost: 15s
This Rune may be etched onto a suit of armor. This Rune allows the user to call “Refresh All Armor by Rune” once. This
effect can be Refreshed a Standard Rest. A character may only have a single Armor Rune of Lasting Repair etched on their
armor at any time.
Weapon Rune of Defense
Cost: 15s
This Rune may be etched onto a weapon or shield. It allow the character a single use per Standard Rest and may call
“Guard Weapon by Rune” to negate the first melee or missile attack. A character may only benefit from a Single Weapon
Rune of Defense at any time.
Portal Rune of Closure
Cost: 10s
This Portal Rune may be etched onto Portal Placard and transferred onto a magical portal. This Rune will close the portal.
In cases of permanent portals, this Rune should make an active portal dormant for a period of time. Please note that this
effect may not be permanent, and portals may reactivate if someone else is activating them. Once applied, these Runes
disappear immediately upon etching.
Flesh Rune of Survival
Cost: 20g
This Rune may be etched onto someone’s skin. This Rune will allow a character to come back from the brink of death.
After being dead for five minutes, this character may spend this Rune and one fate to call “With Fate, Purge Death by
Rune” instead of becoming a dead spirit. Due to the unnatural effect of this Rune, some may consider this Rune to be as
nefarious as Necromancy.
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All about Production Recipes
A character may find a recipe that allows them to make a specific production item. These recipes normally allow
5 items to be created before the recipe is destroyed. All Recipes should include:
Name of the Item
Production Type and Level
Cost to Create
Number of Charges
Effect
Special (any other requirements for creation)
As an example:
Recipe of Greater Magic Wand: Incinerate
Level 3 Infusion
Cost: 9 Gold
Charges: 5 (ooooo)
This Recipe allows you to create a "Wand of Incinerate." This wand has 5 charges and allows you to spend 1 charge to
throw a packet for "Death by Fire."
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